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QUICK START 

Apple I1 Family: Insert the program disk in drive 1; turn on the computer; 
follow screen prompts. 

MS-DOS: Boot DOS 2.11 or higher. Insert Program Disk 1 in drive A, Disk 2 
in drive B. At the A>, type algebra; press <Enter>; follow screen prompts. 
(Do not try to install to a hard disk using DOS copy commands. See p. 13.) 

double-click the ABP program icon. 
Macintosh: Boot with System 6.04 or higher. Insert the program disk and 

Sign In 
Enter your name; press <Return>. If prompted, select date; press <Return>. 

Select a Level and a Subject 
Mouse: Point and click the Level menu; drag and release to select a level. 

Keyboard (Apple I1 and MS-DOS): Press c E s o  to access the menu bar. Use 
Select a subject from the Subject menu in the same way. 

+ to access the Level menu and + to select a level; press <Return>. Select 
a subject from the Subject menu in the same way. 

Select an Activity 
Mouse: Double-click an activity icon (picture) on the Main screen. 
Keyboard (Apple I1 and MS-DOS): Use * to select an icon; press <Return>. 

USING THIS MANUAL 

J For a complete description of the program's features and 
activities, read the Overview on pages 1-10. 

J Directions for using the program are separated into three 
chapters: (1) for MS-DOS computers, (2) for Macintosh, and 
(3) for the Apple I1 Family. See the chapter for your 
computer. 

J Hard disk installation instructions can be found on page 
13 for MS-DOS and page 39 for Macintosh. 
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NOTICE 
Davidson & Associates. Inc. reserves the right to make improvements in the product described in this 
manual at any time and without notice. 

W A RK ANTY 
This program will perform substantially in accordance with the published specifications, the documenta- 
tion, and authorized advertjsing. Davidson & Associates. Lnc., when notified of significant errors within 
ONE YEAR of purchase, will at its option: 1) correct demonstrable. significant program or documenta- 
tion errors within a reasonable period of time; or 2) provide the customer with a functionally equivalent 
disk; or 3) provide or authorize a refund. 

If the program disk is damaged within FIVE YEARS of purchase, Davidson & Associates. Inc. will  re- 
place the disk with a functionally equivalent disk w i t h  a reasonable period of time, upon receipt of the 
damaged disk by Davidson & Associates, Inc. 

Davidson & Associates, Ine. does not warrant that the functions of the software wdl meet your require- 
ments or that the software will operate error-free or uninterrupted. Davidson & Associates, h c .  has used 
reasonable efforts to minimize defects or errors in the software. You assume the  risk of any and all dam- 
age or loss from use, or inabilily to use the software. 

Davidson & Associates, Inc. makes no  other warranties, express or implied, with respect to the manual 
or the software described in this manual. In no event shall Davidson & Associates, Inc. be liable for 
direct or indirect, incidcnval or consequential damages resulting from any defect in the software, even if 
Davidson & Associates, Inc. has bcen advised of the possibility of such damages. Some states do not 
allow the exclusion or limitation of implied warranties or liability for incidental damages, so the above 
limitations or exclusions may not apply to you. 

?he software and the manual are copyrighted. All rights are reserved. They may not, in whole or  part, be 
copied, photocopied, reproduced, translated or reduced to any electronic medium or machine-readable 
form without prior consent, in writing, from Davidson & Associates, Inc. The user of this product shall 
be entitled to use the product for his or her own use, but shall not be entitled to sell or transfer reprodue- 
tions of the software or manual to other parties in any way, nor to rent or lease the product to others 
without written permission of Davidson & Associates. Inc. 

ProDOS and MouseGraphics Toolkit are copyrighted programs of Apple Computer, Inc. licensed to  
Davidson & Associates, Lic. to distribute for use only in combination with Alp-Blarfer Plus. ProDOS 
and MouseGraphics Toolkit shall not be copied onto another disk (except for archival purposes) or into 
memory unless as part of the execution of Alge-Blaster Plus. When Alge-OlaFler Plus has completed 
execution, ProlIOS and MouseGraphics Toolkit shall not be used by any other program. Apple Com- 
puter, Inc. makes no warrantics, express or implied, regarding the enclosed computer software package, 
its merchantability or its fitness for any particular purpose. The exclusion of implied warranties is not 
permitted by some states. The above exclusion may not apply to you. This warranty provides you with 
specific legal rights. There may bc other rights that you may have which vary from state to state. 

The DeskMate System is liccnsed by Tandy Corporation. The terms Apple and Macintosh are registered 
trademarks of Apple Computer, Inc., MS-DOS is a registered trademark of Microsoft Corporation, and 
Tandy and DeskMate are registered trademarks of the Tandy Corporation. 

Copyright 0 1993 Davidson & Associates, Inc. 
1’. 0. Box 2961 Torrance, CA 90509 

Customer Support ( 8 0 )  556-6141 Sales (800) 545-7677 

020893 



ALGE-BLASTER PLUS - AN OVERVIEW 

Welcome to Alge-Blaster Plus, a comprehensive algebra program de- 
signed by teachers for pre-algebra and algebra students. The program 
focuses on understanding the algebraic process and developing skills 
to solve problems. Specifically, its objectives are: 

J to provide an instructive, interactive, and motivating format 
for improving algebra skills 

J to help students master the basic steps in solving algebraic 
equations 

J to prepare students to solve algebraic word problems 
J to offer practice in basic graphing skills. 

Main Screen - 
Macintosh Version 

Five learning activities help students understand the basics of algebra: 
Learn - Learn the steps to solve equations. 
Solve - Practice solving equations. 
Translate - Convert word expressions to algebraic expressions. 
Graph - Practice working with points and slopes. 
Alge-Blaster PZus Game - Protect the space station by apply- 
ing basic graphing skills developed in the Graph activity. 
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Alge-Blaster Plus was designed to supplement classroom instruction 
and is especially effective in reinforcing material presented in class. It 
will also serve as an excellent review for students taking a College 
Board Exam or a higher-level math course. To use Alge-Blaster Plus 
successfully, a student should have already mastered the four basic 
math operations using whole numbers, fractions, and decimals. 

Activity 1 - Learn 

The objective of the Learn activity is to present a step-by-step ap- 
proach to solving algebra problems. This interactive tutorial presents 
the fundamental steps students must learn and then provides guided 
practice in their application. Key algebraic terms and properties are 
introduced and defined. 

Learn Activity - 
MS-DOS Version 

-4 t (-8) 

An example problem is presented with an explanation of each step and 
its solution. The student controls the pace of instruction and can re- 
view any of the steps. After the example problem is completed, the 
student can work three similar practice problems by following the 
program’s prompts. 
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Skills Addressed in Activities 1 and 2 
Integers - adding, subtracting, multiplying, and divid- 
ing 
Order of Operations - using the rules to solve equa- 
tions 
Monomials and Polynomials - combining and simpli- 
fying using the four basic operations 
Factoring - recognizing and applying fundamental 
forms 
Equations - evaluating expressions containing positive 
integral exponents, and linear equations containing 
integers, fractions, and decimals 
Systems of Equations - solving systems of linear 
equations 
Algebraic Fractions - combining and simplifying 
using the basic operations 
Radicals - simplifying and using the basic operations 
Quadratic Equations - solving by factoring and using 
the quadratic formula 

Activity 2 - Solve 

The objective of the Solve activity is to provide students an opportu- 
nity to reinforce the concepts and skills that they learned in the pre- 
ceding activity. Students practice applying the steps as they solve 
problems on their own. In this activity, the student should solve the 
problems on paper, entering only the final answer for each problem. 
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Solve Activity - 
MS-DOS Version 

7 a - 1 2 ,  a - 4  

8 a -  16 

If a student needs help with any of the steps, hints can be accessed. The 
first hint is a worded prompt such as "Combine like terms." If the 
student needs more help, the corresponding step will be shown. Hints 
demonstrate the fundamental steps necessary to solve the problem. 

Activity 3 - Translate 

The objective of the Translate activity is to prepare students for solv- 
ing algebraic word problems. In this multiple-choice activity, students 
learn to set up an expression or equation by translating words into an 
algebraic expression (or an algebraic expression into words). Students 
will learn the usefulness of variables and strengthen their understanding 
of the math symbols and vocabulary used in word problems. 

Translate Activity - 
Apple Version 

I I, 25 = y ,  28 
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Students begin by translating simple phrases and advance to sentences 
involving multiple variables and operators commonly used in alge- 
braic word problems. Phrases and expressions are presented in three 
levels of difficulty: Level 1, one operator; Level 2, two operators; and 
Level 3, an operator on each side of the equal sign. 

\ 

B 
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2 
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8 

Skills Addressed in Activity 3 
J Setting up algebraic expressions and equations 
J Translating phrases involving worded expressions (such 

as more than, decreased by, product of, quotient oj) 
into algebraic expressions 

J Translating algebraic expressions involving one or two 
variables into words 

-8 - 6 - 4  -2 0 2 4 6 8 . . 
. .. . 

. 
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Activity 4 - Graph 

The objective of the Graph activity is to familiarize students with the 
coordinate system and slopes of lines. As students develop these 
graphing skills, they learn to better understand and visualize the 
mathematical relationships that can be illustrated on a graph. 

ED- Graphing Leuel 1 

Graph Activity - 
Macintosh Version 

Find Point 

I P 
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In Level 1, students become familiar with the coordinate system by 
locating and labeling points on a graph. They will begin to draw con- 
clusions about the points, realizing for example that (0,2) is on the y 
axis and (-2,-2) is in Quadrant 111. After students are comfortable with 
this task, they can challenge themselves by playing against the clock. 

In Level 2, students learn to find the slope of a line given two points 
or find a second point on a line given one point and the slope. When a 
student correctly identifies the slope or second point, a line is drawn to 
visually reinforce the concept of slope. 

Skills Addressed in Activity 4 
J Locating ordered pairs on a graph 
J Labeling the ordered pair for a point 
J Calculating the slope of a line 
J Determining a point on a line, given one point and the 

slope 
~ ~~ 

Activity 5 - Alge-Blaster Plus Game 

The objective of the game is to provide students a fast-paced, motivat- 
ing format for reinforcing the new graphing skills that they’ve learned. 

Alge-8laster Plus Game - 
Macintosh Version 
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The object of the game is to protect your space station from asteroids. 
Use a space web to block the path of an asteroid, or blast it with a 
laser beam. To put up a space web, decide where to place it, quickly 
estimate coordinates, and enter two ordered pairs for that location. The 
line drawn between these points will act as a barrier. To aim the laser 
and blast an asteroid, enter a slope. You must understand the relation- 
ship between the slope of a line and its angle to be successful. 

The game’s level of difficulty automatically increases as the student 
experiences success. At higher levels, more asteroids threaten the 
space station. A student can choose to start at any level. 

Skills Addressed in Activity 5 
J Estimating the location of coordinates on a graph 
J Estimating and visualizing the slope of a line 
J Developing strategies for protection of the space station 

Scoring 

After each activity (except the Learn activity), a scoreboard will 
appear. In the Solve and Translate activities, scores are percentages 
of problems correct out of those attempted. In Graph, 20 points are 
earned for a correct answer on a first try, 10 points on a retry. When a 
student plays against the clock, 10 points are earned for each second 
remaining after the student answers correctly. 

In Level 1 of the Alge-Blaster Plus Game, a player receives 25 points 
for exploding an asteroid or bouncing it off a space web. The number 
of beams remaining in the lasers are awarded as bonus points at the 
end of the level. As you advance to a higher level, a flying object will 
cross the screen. To earn additional points, hit the object twice with 
the laser. Scoring at higher levels increases proportionately. 
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Options 

Sound and Graphics may be switched on or off anytime except during 
the game. Options in Translate and Graph can be changed while 
using those activities by selecting Options from the Activity menu. 

Help/Student Aid 

On-line help is available from the Student Aid menu (MS-DOS), the 
menu (Macintosh), and the Help menu (Apple 11): 
J Info - information about keystrokes necessary for the current 

activity (This menu item is called Help in the Mac version.) 
J Terms - a list of algebraic terms and definitions 
J Hints - for Solve (Practice with Help option) 
J Grid - lines like graph paper for Graph (In the Macintosh 

version, Grid can be found in the Activity menu.) 

Editor 

The Alge-Blaster Plus Editor is a valuable teaching tool which greatly 
expands the range of the program. Complete instructions for using the 
Editor may be found starting on page 28 for MS-DOS, page 48 for 
Macintosh, and page 67 for the Apple version. 

Printing 

Student records, scoreboards and certificates may be printed after 
completing any activity except the Learn activity. 
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Teaching Tips 

Learn and Solve 
Use a number line to introduce addition and subtraction of 
integers. Once students understand the concept, they will have 
the background necessary to use the rules introduced in most 
textbooks and in Alge-Blaster Plus. 
Discuss “real world” situations which require the addition and 
subtraction of integers. Gain and loss of football yardage and 
deposit and withdrawal of money from a bank account are con- 
crete experiences to which most students can relate. Encourage 
them to think of additional examples. 
Use a two-sided balance to visually reinforce the Addition 
Property of Equations. If you add some weight to one side, the 
same amount of weight must be added to the other side in 
order for the scale to stay balanced. 
Emphasize the importance of checking answers. Answers can 
be checked quickly by substituting the solution for the value of 
the variable into the original equation. 
Relating addition and subtraction of radicals to combining like 
terms will help students avoid the common error of adding the 
numbers under the radical sign. 

Translate 
Ask students to make a list of key words found in word prob- 
lems in their textbooks. Have them group the words by opera- 
tion (e.g., plus and increase are addition words). 
Review the Commutative Property so that the students will re- 
member that order is not important in addition and multiplica- 
tion. Emphasize that the Commutative Property does not apply 
to subtraction and division by having the students see what 
happens when they switch the order. 
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In Level 2, Alge-Blaster Plus uses parentheses in those ex- 
pressions where they are absolutely necessary. Also, optional 
parentheses are sometimes used for additional clarity. Chal- 
lenge students to discover which parentheses are necessary by 
changing the position of the parentheses or by working the 
problems without parentheses. 
Have students write translation problems for one another. Cre- 
ating problems and three good distractors (wrong answers) 
will help students understand the process of translating phrases 
and expressions. 

Graph 
Discuss common uses of graphs and encourage students to 
think of examples. 
Ask students to create their own graph by gathering data about 
their classmates (number of people in their families, birthdays, 
etc.) and plotting this data. 
When working with Level 1 - Find point, have students look 
at the given coordinate and guess in which quadrant the point 
will be, then verify their estimates. 
When working with Level 1 -Label point, have students draw 
conclusions about a selected point, such as whether the x and y 
values are positive, negative, or zero. Students can use the 
program to verify their conclusions. 
When working with Level 2, encourage students to make dis- 
coveries about slopes. Students may discover that a line with a 
slope of 4/5 is the same as -4/-5 and 16/20. They can practice 
estimating the slope of a line by noticing that its rise is greater 
or less than its run, then deciding whether its slope is negative, 
positive, or zero. Have students check the accuracy of their 
estimates by using the program. 
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HOW TO USE THE MS-DOS VERSION 
(Do not install on a hard disk using DOS copy commands. See page 13.) 

System Requirements 

J IBM/Tandy (or MS-DOS computer) with 5 12K 
J CGA, EGA, MCGA, VGA, TGA, or Hercules card 
J DOS 2.1 1 or higher 
J printer, mouse (optional) 

Moving Around in the Program 

Alp-Blaster Plus utilizes the Tandy DeskMate Interface which allows 
easy access to all menu items using mouse or keyboard. Menus are lo- 
cated on the menu bar at the top of the Main screen. A grayed item is 
temporarily unavailable. For example, the Graph activity has only two 
levels, so Levels 3 and 4 appear dim when that activity is selected. For 
a description of Main screen menus, see pp. 33-34. 

~Iategers  
Order d Operations 
nono. a PLIIY. 
rictoring 
Gquatlons 
System d E g u a t i a s  
Ilgcbraic Fractiom 
Rdicda 
quadratic EqurtiorP 

t 
to select item 

4 

Selecting a Menu Item Using the Keyboard 

Press the function key (F2-F6, F10) for the menu title you wish. 
Use 4 and t to highlight the desired item; press <Enter>. 
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Selecting a Menu Item Using a Mouse 

Point to a menu title and click; the menu will drop down. 
Hold down the mouse button and drag the pointer downward to 
highlight an item. Release the button to select it. 

Using Accelerator Keys 

Some menu items are followed by <Ctrl> and a letter (e.g., <Ctrl>E). 
These represent keyboard shortcuts. To use the shortcut feature: 

Press <Ctrl> and the letter key at the same time. 

Making Other Choices Using the Keyboard 

When options or choices on the screen are boxed, <Tab> be- 
tween fields (boxes); use t and 4 to move the cursor within a 
field; press <Enter> when input is complete. 
When input is required in more than one place on a screen (as 
in Setup or an activity option box), use t or 4 to move the 
cursor and <Tab> between fields. Type in information or press 
<Space> to mark. Press <Enter> when all input is complete. 
To make button selections (Le., when choosing Record Keep- 
ing options), use .) to place the cursor under your selection; 
press <Space> to activate it. Press <Enter> or click OK. 

Making Other Choices Using a Mouse 

When options or choices on the screen are boxed, point and 
click the box of your choice. 
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When input is required in more than one place (as in Setup or 
an activity option box), point and click to move the cursor or 
make selections. When all input is complete, click OK. 

Installing the Program on a Hard Disk 

Do not use DOS commands to install or remove files. Before in- 
stalling the program on your hard disk, please run the program from 
the floppy drive. (See pp. 14-16.) After you have verified that the pro- 
gram runs correctly from your floppy drive, follow these directions to 
install Alge-Blaster Plus to your hard disk: 

Start the hard disk as usual. 
Insert the Alge-Blaster Plus disk (5  1/4"- use Program Disk 1; 
3 1/2" - use Program Disk) into a floppy drive. 
At the prompt, type a: or b: and press <Enter>. You must log 
on to the drive that the Program Disk is in. 
At the prompt, type hdinstal c:\algebra and press <Enter>. 
You may install to a hard drive of any name or a subdirectory 
within an existing directory, e.g., hdinstal d:\educ\algebra. 

If you have any problems, see Troubleshooting, pp. 35-36 and 75. 

If your computer uses the Tandy DeskMate Desktop interface, see your 
DeskMate User's Reference to install the program from the Desktop. 

To remove the program from your hard disk: 
Put the Alge-Blaster Plus Program Disk in drive A. 
At the prompt, type a: or b: and press <Enter>. You must log 
on to the drive that the Program Disk is in. 
At the prompt, type uninstal c:\algebra and press <Enter>. If 
you have installed to a hard drive of another letter designation 
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or to a subdirectory, be sure to type the complete pathname, 
for example uninstal d:\educ\algebra. 

Starting the Program 

Tandy Note: To run on a Tandy 1000 TL, loo0 SL, or 1000 RL, you will 
need to run from the DeskMale desktop. Consult your DeskMate User's Ref- 
erence for detailed information on running an application from the desktop. 

From Your Hard Disk 
Start your computer as usual, from the hard disk. 
At the prompt, type cd algebra and press <Enter>. This will 
access the algebra subdirectory. 
At the prompt, type algebra and press <Enter> to start the 
program. Now turn to Signing In on page 16. 

Using One 5 1/4" Drive 
Start the computer using DOS 2.11 or higher. 
Insert Program Disk 1 into drive A. 
At the A>, type algebra and press <Enter>. 
When the screen displays the following message: 

File Not Found 
Unable to locate file DMCSR.RRS 
Press Enter to search entire system, 
or Esc to cancel system search. 
<O>k, cC>ancel ..., 

remove Program Disk 1 from drive A; insert Program Disk 2 
into drive A; press <Enter>. 
If the message is repeated, press <Enter> again. 
When the screen displays the File Not Found message: 

Unable to locate file ALGEBRA.PDM 
Press Enter to search entire system, 
or Esc to cancel system search., 

14 How to Use the MS-DOS Version 



remove Disk 2 and insert Disk 1 into drive A; press <Enter>. 
If the message is repeated, press <Enter> again. 
When the screen displays the Insert Disk message: 

Please insert the Alge-Blaster Plus Data Disk., 
remove Program Disk 1 from drive A; insert the Data Disk in 
drive A; press <Enter>. Now turn to Signing In on page 16. 

Using Two 5 1/4" Drives 
Start the computer using DOS 2.1 1 or higher. 
Insert Program Disk 1 into drive A. 
Insert Program Disk 2 into drive B. 
At the A>, type algebra and press <Enter>. 
If you get the message: 

File Not Found 
Unable to locate file DMCSR.RRS 
Press Enter to search entire system, 
or Esc to cancel system search. 
cO>k, <C>ancel ..., 

remove Program Disk 2 from drive B and follow the instruc- 
tions for using one 5 1/4" drive. 
When the screen displays the Insert Data Disk message: 

remove Program Disk 2 from drive B; insert the Data Disk into 
drive B; press <Enter>. Now turn to Signing In on page 16. 

Please insert the Alge-Blaster Plus Data Disk., 

Using One 3 1/2" Drive 
Start the computer using DOS 2.11 or higher. 
Insert the Program Disk into drive A. 
At the A>, type algebra and press <Enter>. 
When the screen displays the Insert Data Disk message: 

remove the Program Disk from drive A; insert the Data Disk in 
drive A; press <Enter>. Now turn to Signing In on page 16. 

Please insert the Alge-Blaster Plus Data Disk., 
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Using Two 3 1/2" Drives 
Start the computer using DOS 2.11 or higher. 
Insert the Program Disk into drive A and the Data Disk into 
drive B. 
At the prompt, type algebra and press <Enter>. Now read 
Signing In below. 

Using One 3 1/2" and One 5 1/4" Drive 
Start the computer using DOS 2.1 1 or higher. 
Insert the 3 1/2" Program Disk and the 5 1/4" Data Disk into 
the drives. 
If your 3 1/2" dnve is drive A, type a: and press <Enter>. If 
it's drive B, type b:. 
At the prompt, type algebra and press <Enter>. Now read 
Signing In below. 

Note: If the program still does not load, there may be an incompatibil- 
ity between the graphics display mode the program is using and your 
graphics adaptor. You can correct this manually; see Troubleshooting 
for Starting the Program, pp. 35-36. 

Signing In 

Now that the program has been loaded, begin by typing your name 
into the box that appears. 

Type a name (up to 8 characters); press <Enter>. 

Using Setup and Its Options 
The options in Setup allow you to customize your Program Disk: 

Select F10. Press 4 once and then press <Enter>. The Setup 
screen will appear. 
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If you wish to change any information on the Setup screen: 
Access the Options (F2) menu. 
Select the item you wish to change. A dialog box will appear in 
which you may indicate your choices. 

Setup 

Setup - 7 : z o  pr 

h i n t i n g  Deu1Ge: O t h x  m s c  
h b i c  Cllck Speed: 3 

Driuer -: dmpda=:l 
L l n e  Iced f i l t u :  On 
rrinter ports: LPTl  
Characters Per Inch: 12 

I 

The Mouse Option allows you to select a type of pointing device and a 
double-click speed. 

Select a Pointing Device type. (Select a serial mouse port if 
you chose Serial Mouse.) 
Select a double-click speed; press <Enter> or click OK. 

The Printer Option must be set to ASCII. This is the only printer 
driver the program uses. It supports all printers. 

Turn the Line Feed Filter box on or off by highlighting and 
pressing <Space>. 
Select the number of characters per inch and a Printer Port; 
press &nter> or click OK. 

The Color Option allows you choices which depend on the type of 
video card in your computer. (These color changes are temporary and 
must be reset each time you use the program.) 
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The Date and Time Option allows you to change the date and time 
without exiting to DOS. 

Enter the correct date and time; press <Enter> or click OK. 

The Communications Settings cannot be changed. 

To leave Setup, select Exit from the Options menu or press <Ex>.  

Using the Activities 

The five Alge-Blaster Plus activities are represented by icons (pic- 
tures) on the Main screen. To access an activity: 

Highlight an icon by using keyboard arrows and pressing 
<Enter>, or double-click the desired icon with the mouse. 

To quit an activity: 
Press <Est> or select Stop from the Activity menu. 

Activity 1 - Learn 
This activity consists of examples and practice problems. 

Highlight the Learn icon on the Main screen. 
Select a Subject from the Main screen’s Subject menu. 
Select a Level from the Level menu. 
Press <Enter> or click the Learn icon. 

The first example problem will appear on the screen. 
Study the example problem and the text that appears below it. 
Select Next when you are ready to continue. 
Study the first step and the explanation of how this step was 
reached; select Next to continue. 
Continue viewing the demonstration steps in this manner. The 
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number of steps in each example problem vanes. If you want 
to review any of the steps in the problem, select Previous. 

After the example problem, the first of three practice problems will be 
presented along with instructions for the first step. 

Read the practice problem and the instructions for the first 
step; select Next. 
Enter the solution to the first step; press <Enter>. (Use <Back- 
space> to erase.) You have two opportunities to answer cor- 
rectly. Otherwise, the correct answer will be supplied. 

? a - 1 2 ,  a - 4  

Learn Activity 

I 

Press <Enter> when you are ready to go to the next step. 
Study the second step; press <Enter> or click OK. 
Enter or complete the second step solution; press <Enter>. 
Continue completing steps until you solve the problem. 

the special algebraic characters which you see dis- 
played at the bottom of the screen. See page 32 for 
complete instructions on how to use these characters. 
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If you want to review any of the steps, press cCtrl> R. Select Previ- 
ous to continue moving backward through the steps or select Next to 
move forward through the steps of the problem. 

A second example problem and three more practice problems will be 
presented. After completing the practice problems, press any key to 
return to the Main screen. 

Activity 2 - Solve 
This activity reinforces the concepts and skills studied in Learn. 

Highlight the Solve icon on the Main screen. 
Select a Subject from the Subject menu. 
Select a Level from the Level menu. 
Select Start with from the Activity menu if you want to begin 
with a particular problem. 
Press <Enter> or click the Solve icon. 
Select an option for Solve: either Practice with help or Solve 
on your own. 
Study the problem at the top of the screen. 

If you selected Practice with help, you can ask for a hint. 
Enter the answer if you can; press <Enter>. 
If you want help either before or after attempting to answer, 
select Hints from the Student Aid menu or press cCtrl>H. If 
you’d like more help, select Next to see the next hint. You 
may view a prior hint by selecting Previous. To leave the hint 
box at any time, select OK. 
Enter the final answer and press <Enter>. You have two op- 
portunities to answer correctly before the answer is supplied 
for you. 
Press <Enter> to go to the next problem. 
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If you selected Solve on your own, hints are not available. 
Solve the problem using pencil and paper if necessary. 
Type in the answer and press <Enter>. You have two opportu- 
nities to answer correctly before the answer is supplied. 

Solve Activity 

x t 4  2 x - 1  t 
5 5 

3x t 3 
5 

Press <Enter> to go to the next problem. 
There are between 10 and 15 problems in each file. When you 
finish the problems and the scoreboard appears, press any key 
to return to the Main screen. 

Activity 3 - Translate 
In this multiple-choice activity, you will translate words into algebraic 
expressions or algebraic expressions into words. 

Highlight the Translate icon on the Main screen. 
Select a Level (1-3) from the Level menu. (Note: The Subject 
menu is not used with this activity.) 
Press <Enter> or click the Translate icon. 
Select a format option: Choose Equation, Choose Phrase, or 
Mixed. 
Read the phrase or equation at the top of the screen; then type 
or click the letter of the correct answer choice, or select it by 
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using t and 4 and pressing <Enter>. You have two opportu- 
nities to answer correctly before the answer is supplied. 

Translate Activity 

a nrrkr x diuldcd tg 25 is b] the quotient af L number y and 28 

a nunber x dininished ty 25 is @ 28 less than a number g 

!@ D mnbcr y diuidcd ty ,?E 

D mnber x diuided ty ZS is @ a nunber y dininished bg 28 

-7 

the quotient of 25 and a number x is 

Great! 

Press <Enter> to go to the next problem. 
When you finish and the scoreboard appears, press any key to 
return to the Main screen. 

Activity 4 - Graph 
In this activity, you will become familiar with the coordinate system 
and the slopes of lines. 

Highlight the Graph icon on the Main screen. 
Select a Level (1 or 2) from the Main screen’s Level menu. 
(Note: The Subject menu is not used with this activity.) 
Press <Enter> or click the Graph icon. 

Level 1 
Select an option: Find Point, Label Point, or Mixed. 
To turn on the timer, click on the box, or press t or 4 to move 
to the timer box and <Space> to select. 
Select OK to accept option choice(s). 
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If you would like a grid background, select Grid from the 
Student Aid menu. 

Graph Activity - 
Level 1 

Find Point 
Look at the ordered pair displayed in the Find Point box at the 
right. Find the corresponding point on the graph. 
Click or use mows to move the selection box, then click again 
or press <Enter> to select the point on the graph which corre- 
sponds to the ordered pair in the Find Point box. 
Press <Enter> to go to the next problem. 

Label Point 
Look for the boxed point on the graph. 
Enter the corresponding ordered pair in the Label Point 
box on the right side of the screen; press <Enter>. (The comma 
will be supplied for you. To enter (3,4), type 3 and then 4.) 
Press <Enter> to go to the next problem. 

Mixed 
Mixed is a combination of the Find Point and Label Point options. 
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Level 2 
Select Find Point, Find Slope, or Mixed. 
To turn on the timer, click on the box, or press 
move to the timer box and <Space> to select. 
Press <Enter> or click OK to accept option choice(s). 
If you would like a grid background, select Grid from the 
Help menu. 

or 4 to 

Find Point 
Look at the coordinates shown in the Point and Slope boxes. 
Use the slope and point 1 to find point 2. Use the arrow keys 
or mouse to move the selection box from point 1 to point 2. 
For example, if the slope is 4/5, move the box up 4 points and 
over 5 points to the right. 
Press <Enter> or double-click when the selection box is at the 
correct point. 
Press <Enter> to go to the next problem. 

Find Slope 
Find the slope between the two points displayed on the graph. 
Calculate the slope of the line between the two points by using 
the point slope formula (slope = y2-y1 / x2-x1). For example, if 
the first point is (3,2) and the second point is (5,4), the slope 
would be 4-2/53 = 2/2 = 1. Enter the slope with a slash (/) 
between the two numbers (rise/run); press <Enter>. 
Press <Enter> to go to the next problem. 

Mixed 
Mixed is a combination of the Find Point and Find Slope options. 

In Graph, you have two opportunities to answer correctly before the 
answer is supplied. If the timer is on, you have 20 seconds to answer. 
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Activity 5 - Alge-Blaster Plus Game 
In this arcade-style game, you will use your graphing knowledge to 
defend your space station against asteroids. 

Highlight the Alge-Blaster Plus Game icon on the Main screen. 
Select a Level (14 )  from the Level menu. 
Press <Enter> or click the Alge-Blaster Plus Game icon. 
Select Normal game speed or Fast game speed from the 
Activity menu; press <Enter>. 

Alge-Blaster Plus 

Game 

Ucb Control: =I] 

Shoot a laser beam to destroy the asteroids before they hit your space 
station. To blast an asteroid with a laser: 

Select (highlight) a laser using t and 4 .  There is a laser in 
each corner of the space field. 
Enter a slope (e.g., 2/3); press <Enter>. A laser beam will be 
launched at an angle equal to the slope you entered. Lasers 1 
and 3 require a positive slope, 2 and 4 require a negative slope. 
Each laser can emit 20 beams. (The amount remaining is 
shown at the bottom of the screen.) Hint: If you are having 
trouble visualizing the direction of a slope, enter a series of 
slopes with similar coordinates. For example, enter 5/1, 5/2, 
5/3, and 5/9 and notice how the slope changes in direction. 
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Space webs can help you protect your space station by blocking the 
path of the asteroids. To create a space web: 

Press <Tab> to select the Web Control box. 
Decide where you want to put the web and enter a coordinate 
pair for the first point. 
Enter a coordinate pair for the second point; press <Enter>. A 
line, or space web, will be drawn between these points. Aster- 
oids will bounce off this barrier and explode. The space web is 
temporary and will disappear after 25 seconds. (Space web 
remaining is indicated at the bottom of the screen.) 

If your space station is destroyed three times, the game is over. If you 
successfully defend your station, you will advance a level. Levels be- 
come increasingly difficult (more asteroids appear at one time). 

Bonus 
As you advance to a higher level, a laser will be selected for you and 
an object will cross the screen. To earn bonus points, hit the flying 
object twice. You’ll also earn points for any unused beams and webs. 

Using Record Keeping 

This feature allows you to save your scores and keep a cumulative 
record. First, prepare a disk on which to save student records. 

Format a disk using DOS. 

Now start the Alge-Blaster Plus program and sign in. 
Select Record Keeping from the File menu. (A check in front 
of the item on the menu indicates the feature is on. Selecting 
this item again will turn it off.) 
Insert your records disk into any drive. 
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In the options box, use t or 4 to choose either Create a new 
record file or Add to an existing record file. 

If you are creating a new file: 
Select Create a new record file; press <Enter> or click OK. 
A Save File box will appear. In the Save as field, indicate the 
drive where your records disk is located and the complete 
pathname for your file (for example, b:Leslie). 
Select Save. The file will have an extension (.abr). If a file 
with the same name exists on the disk, you will get a “File 
already exists, overwrite?” message. If you answer yes, 
the old file will be erased and replaced with the new file. 

If you are adding to an existing record file: 
Select Add to an existing record file; press <Enter>. 
If the drive displayed above the File box differs from the drive 
containing your records disk, use 4 or 
select the correct drive; press <Enter>. 
Use 4 or t to select the desired file and press <Enter>. 
The filename will appear in the Open File box. Press <Enter> 
or click OK. (The program will ask you to insert the records 
disk at the end of each activity so that the score can be saved.) 

in the File box to 

Viewing a Record 

Insert your records disk. 
Select See record from the File menu. 

If the drive displayed above the File box differs from the dnve 
containing your records disk, use 4 or t to select the correct 
drive; press <Enter>. 
When the drive displayed is the one containing your records 
disk, the record files on the disk will be listed in the File box. 
Use t or 4 to select the desired file; press <Enter>. 
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Printing a Record 
Make sure that you have entered the information about your printer in 
Setup and that your printer is turned on. 

Select Print record from the File menu. 
Insert your records disk. If the drive displayed above the File 
box differs from the drive containing your records disk, use 4 
or + in the File box to select the correct drive; press <Enter>. 
When the drive displayed is the one containing your records 
disk, the record files on the disk will be listed in the File box. 
Use + or 4 to select a file; press <Enter>. 

Using the  Editor 

The Editor is a valuable teaching tool which expands the range of the 
Alge-Blaster PZus program. Use it to create your own algebra prob- 
lems to use in the Solve activity. First prepare a disk on which to save 
your new data. 

Format a disk using DOS. 

Restart the Alge-Blaster Plus program and sign in. When the Main 
screen appears: 

Select Run Editor from the File menu. 
If the File Not Found message box appears displaying the 
message: 

Unable to locate file EDIT.ABP 
Press Enter to search entire system, 
or Esc to cancel. 
< O>k, <C>ancel.. ., 

remove the Data Disk. 
Insert Program Disk 1 into the drive that the Data Disk was in 
and press <Enter>. 
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From the File menu, select New to create a new data file; 
select Open to edit or add to an existing data file. 

Entering a Problem 

J You may enter up to 25 problems per file. 
J Use only the letters a, by c, x, y, and z for the 

J Pressing D or d creates a division sign. 
J To use any of the special algebraic characters and 

symbols at the bottom of the Editor screen, press 
<Ctrl> and F1-F5 at the same time. The symbol 
will appear where the cursor is placed. See pg. 32. 

variables in your problems. 

Step 1 - Enter an expression or equation. 
Enter a problem using the special characters and variables 
mentioned above. 
Use <Space> to center the problem on the screen; press <Enter>. 
The problem will appear on the screen exactly as entered. 

Help F, Jun t, 1990 6UP Editor - Untitled 8:ze  p~ 

Fi le  F2 Roblcn F$tep F.1 I! F ~ I I X F ~  _ _  
s t e p  No. I Nunbar of problems. 1 Probla f b .  I 

Editor Screen - 11 
Pleare enter probien. <Return> Step 1 

4 

Slnpl IFy  

I Ctrl.Fi C t r l r n  CtrlrF3 a Ctrl+F4 C t r 1 . E  
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Use t and + to choose the instruction you wish to have displayed 
with this step; press <Enter>. (See Appendix A for a complete list.) 

Step 2 - Enter the solution. 
Enter a solution using operators and symbols. 
Use <Space> to center the solution on the screen and press 
<Enten. 
Use t or + to select an instruction; press <Enter>. (Select 
hint number zero if you do not want a hint to appear.) 

Step 3 - Enter an alternative solution if applicable. 
If the problem does not have a second possible solution, press <En- 
ter>, select hint number zero and press <Enter> again. 

Step 4 -Enter the first intermediate step (optional). 
Intermediate steps are used as hints in Practice with help. If a student 
asks for help, the written hint is actually displayed first, then the 
numerical hint (step). There are 10 intermediate steps available. Use 
as many of these as you need. 

Enter an intermediate numerical step; press <Enter>. 
Select a hint from the list; press <Enter>. 

After entering your last intermediate step: 
Select Next problem from the Problem menu to add another 
problem to your file. Repeat the procedure above. 
Select Save as from the File menu when you are finished 
adding problems to your file. (You may wish to review each 
problem before you close the file.) 
A File box will appear. Insert your custom data disk. 
In the Save as box, type the complete pathname of the file 
without spaces (for example, b:\Custom), then select Save. 
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To review, edit, or add to an existing file: 
Select Open from the Editor’s File menu. 
Insert your custom data disk. 
Use t and 4 to highlight the letter of the drive the disk is in; 
press <Enter>. 
Use t and -C to select the file you wish to view; press <Enter> 
or click Open. 
Select Go to # from the Problem menu to access a specific 
problem. Be sure to save any changes you make to the file. 

Using Your New File With Solve 

You may go directly to the program from the Editor by selecting Run 
Alge-Blaster Plus from the Editor’s File menu. 

Highlight the Solve icon on the Main screen. 
Do not press <Enter>. 
Select Your file from the Level menu. (Your file is available 
only after the Solve icon has been highlighted.) 
Insert your custom data disk; press <Enter>. 
If the drive displayed above the File box differs from the drive 
containing your custom data disk, use C or t in the File box to 
select the correct drive; press <Enter>. 
When the drive displayed corresponds to the drive containing 
your data files, the files will be listed in the File box. (These 
files will have the extension .abd.) 
Use t or 4 to highlight the file you want to use; press <Enter>. 
Select the Solve icon on the Main screen. 
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Using Special Algebraic Characters 

At times it will be necessary to use the special algebraic characters and 
symbols displayed at the bottom of the screen. 

C t r l I l  Ctrl+E! Ctrl+P3 Ctrl+F-f Ctr145 ........... ........... -... .. .... ~ ..... 

To use a special character, place the cursor where you want the charac- 
ter to appear, then: 

Press cCtrl> and a numbered function key (Fl-F5) at the 
same time, and enter as explained below. 

The special character key will remain highlighted on the screen while 
you are in that mode. 

cCtrbF1 The plus/minus sign will be displayed on the screen. 

cCtrbF2 The radical expands as you enter numbers. To exit the 
radical mode, press the same keys again. 

cCtrbF3 Enter an exponent. To exit the exponent mode, press .) 

cCtrbF4 Enter the numerator. Press .) to move the cursor to the 
denominator; enter the denominator. To exit the 
fraction mode, press the .) key again. 

cCtrbF5 The small fraction key allows you to include small 
fractions within large fractions. Enter the numerator 
first. Press .) to move the cursor to the denominator; 
enter the denominator. Press .) again to exit the small 
fraction mode. 

32 How to Use the MS-DOS Version 



Main Screen Menus 

File F2 

New student. . . 
Record keeping . . . 
See record.. . 
Print record . . . 

Run. . . 

About ABP . . . 

Activity F3 

Start 
Start with . . . 
SloD 
Sound 
Graphics 
Options . . . CtrltO 
Review text !&I& 
Normal game speed 
Fast game speed 

Subject F4 

Integers 
Order of Operations 
Mono. & Poly. 
Factoring 
Equations 
Systems of Equations 
Algebraic Fractions 
Radicals 
Quadratic Equations 

Level F5 

Level 1 
Level 2 
Level 3 
Level 4 
Your file. . . 

New student - change student 
Record keeping - turn on/off 
See record - view student’s scores 
Print record - print out scores 
Exit - exit the entire program 
Run - run new DeskMate application 
Run Editor - access Editor to create new data 
About ABP - about the authors 

Start - begin selected activity 
Start with - a specific problem # 
Stop - exit from an activity 
Sound - turn on/off 
Graphics - turn on/off 
Options - change within an activity 
Review text - see prior explanation 
Normal game speed - speed choice 
Fast game speed - speed choice 

These are the subjects available 
in the Alge-Blaster Plus program. 

Levels 1-4 are levels of difficulty of the 
problems within each subject area. 

Your file - use a custom data file 
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Student Aid F6 

Terms CtrltT 
Hints CtrltH 
Show Grid 

Setup F10 

Info - activity instructions 
Terms - math terms and definitions 
Hints - for Solve (Practice with help) 
Show Grid - lines for Graph activity 

Setup - See pp. 16-18 of this manual for a 
complete explanation. 

Editor Menus 

File (Editor) 

New 
Open.. . CtrltO 
Save CtrltS 
Save as CtrltA 
Run Alge-Blaster Plus CtrltR 
Exit Esc 
About ABP editor. . . 

Problem (Editor) 

Next problem Pg-Dn 
Previous problem Pg-Up 
Insert problem 
Cut problem 
Copy problem 
Paste problem 
Goto# . . .  CtrltG 

Step (Editor) 

Next step CtrltDn Arrow 
Previous step ClrltUp Arrow 
Insert step Ctrltl 
Cut step CtrltX 
Copy step CtrltC 
Paste step Ctrl+V 

New - create a new file 
Open - open an existing file 
Save - save file on disk 
Save as - name and save a new file 
Run Alge-Blaster Plus - return to program 
Exit - leave the program 
About ABP editor - about the authors 

Next problem - go to next problem 
Previous problem - move to prior problem 
Insert problem - insert a problem 
Cut problem - cut to paste elsewhere 
Copy problem - copy to paste 
Paste problem - place cut or copied problem 
Go to # - see a specific problem 

Next step - go to next step 
Previous step - go back a step 
Insert step - insert a step 
Cut step - cut to paste elsewhere 
Copy step - copy to paste 
Paste step - place a cut or copied step 
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Troubleshooting for Starting the Program 

If the program does not load, there may be an incompatibility between 
the graphics display mode the program is attempting to run and your 
graphics adaptor. You may control and correct this manually. 

Floppy Disk Users 
5 1/4" - Insert Program Disk 2. 
3 1/2" - Insert the Program Disk. 
At the A>, type dmvid. All of the graphics modes that the pro- 
gram supports will be displayed. Determine the type of video 
card you have (CGA, EGA, VGA, MCGA, or Herc). If you 
don't know, try using CGA. 
At the A>, type dmvid cga (or whatever mode corresponds to 
your system). 

Hard Disk 
Place the Program Disk (Program Disk 2 if 5 1/4") in drive A. 
Copy the files dmvid.exe and dmcsr.cfg from the floppy disk 
to the root directory of your hard disk. 

Type copy a:dmvid.exe c:\ and press <Enter>. 
Type copy a:dmcsr.cfg c:\ and press <Enter>. 

Remove the floppy disk and change to the root directory of 
your hard disk. 

Type c: and press <Enter>. 
Type cd\ and press <Enter>. 

At the C>, type dmvid. All the graphic modes that the pro- 
gram supports will be displayed. Determine the type of video 
card you have (CGA, EGA, VGA, MCGA, or Herc). If you 
don't know, try using CGA. At the C>, type dmvid cga (or 
whatever mode corresponds to your system). 
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Tandy Floppy Disk Users 
If you are running the program on a Tandy lOOOSL or Tandy 
1000TL, you are not using DeskMate and you get the message 
“Unable to locate DMVTC16.RRS,” run the program from 
DeskMate. 

All Users 
If the program still doesn’t work, type set dmconfig=c:\ (or a:\ 
or b:\, depending on the drive you are running the program 
from). Press <Enter>. Try to run the program again. If you 
have to do this step to get the program to run, you should put 
the set dmconfig=c:\ line into your autoexec.bat file, or type it 
each time you reboot the machine before running the program. 
Consult your DOS manual for instructions on how to alter 
your autoexec.bat file. 
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HOW TO USE THE MACINTOSH VERSION 

System Requirements 

J Mac Plus, SE, 11, IIcx, or IIci with at least 1 meg. of memory 
J System 6.04 or higher 

If your Macintosh SE/30 or Macintosh I1 computer is ~ 

equipped with 4 bit color video card and color Quick- 
Draw capable of showing 16 colors or more, set the mon- ~ 

itor to 16 colors or more (through the Control Panel). 
Alge-Blaster Plus will run in full color. I 

Moving Around in the Program 

Features of the Macintosh such as the mouse, menu bar, scroll bar and 
keyboard alternatives are briefly explained here and in the Help menu. 
If you need additional help, please refer to your Macintosh tutorial 
disk or the manual that came with your computer. 

Mouse Terms 
Click - Press the mouse button and release. To double-click, press 

the mouse button two times. 
Click and Drag - Press and hold the mouse button. While holding 

the mouse button, drag the mouse to highlight text or to move 
special characters. Release the mouse button when you arrive 
at the desired location. 

Click and Hold - Press and hold the mouse button down. 
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Menu Bar 
A menu bar is located at the top of the screen. To select a menu item, 
click the menu title in the menu bar, drag through the menu to the 
item, and release the mouse. If a menu item is dimmed or grayed, it is 
not accessible at that time. 

Scroll Bar 
The scroll bar is a rectangular bar along the right or bottom of the 
window. Clicking or dragging in the scroll bar changes the view of the 
document. This is necessary since most of the time the screen does not 
show the entire document. 

Keyboard A1 terna tives 
Some menu items are followed by % and a letter ( e g ,  #E). To use, 
press % and the indicated letter key at the same time. 

In the activities and dialog boxes, pressing <Return> is an alternative 
to clicking an OK or Continue button. 

Main Screen 
The Main screen consists of five activity icons. Double-click an icon 
to start an activity. From the Main screen, you can also select a subject 
and level, access the Editor, and turn Record Keeping on or off. 

Making a Backup 

It is a good idea to make a backup copy of your Alge-Blaster Plus disk 
right away. Put the original disk in a safe place and use your backup 
copy for starting the program or installing the program on your hard 
disk. 
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Installing the Program on a Hard Disk 

Use your backup copy to install Alge-Blaster Plus on your hard disk. 
Create a new folder on your hard disk. 
Drag the Alge-Blaster Plus program icon and the Data folder 
icon over and place them into this folder. (Caution: Do not 
drag the Alge-Blaster Plus System folder onto your hard disk.) 
Double-click the Alge-Blaster Plus icon to start the program. 

Starting the Program 

Sign In 
Turn on your computer. 
If you used a system startup disk, eject it if necessary and 
insert your backup copy of Alge-Blaster Plus. 
Double-click the Alge-Blaster Plus icon. 
Enter your name and click OK. The Main screen will appear 
displaying the five activity icons. 

Using the Activities 

Activity 1 - Learn 
This interactive tutorial activity consists of an example followed by 
three similar practice problems. 

Click to highlight the Learn icon on the Main screen. 
Select a Subject from the Subject menu. 
Select a Level from the Level menu. 
Click the Learn icon again to start the activity. 
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The first example problem will appear on the screen. 
Study the first part of the example problem and the text that 
accompanies it. 
Using the vertical scroll bar, click 4 to scroll and study the 
rest of the steps and explanations. The number of steps in each 
example problem varies. If you want to review any of the steps 
in the problem, scroll t . 

Learn Activity 

Emnnle # 1  - A d d i n g l n k g m  

The set of integers is  made up o f  
posltive an0 negative whole numbers, 
including zero 

- 1 3  + ( -4 )  

When numbers have the same signs, add 
the numbers and use that sign 

PIeor. PWIW Exanple * I  T h .  steps ~ 0 1 1  be 
?.vt.wd as you Cmplet. th. ttrae pcactIce 
p-oblas thot f o l l o w  

Click Continue to view the first of three practice problems. 

Practice problems will be presented with instructions for each step. 
Read and complete the solution to each step of the practice 
problem. (To erase, press <Delete>.) 
Click OK to advance to the next step. If there are no additional 
steps, click OK to advance to the next problem. 

The step you just completed will automatically scroll upward. The 
directions for the step you are currently working on will always be the 
text directly above the. work area. 

Using the vertical scroll bar, click t or 4 to review previous 
steps in the practice problem. 
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Special Characters Palette 
The special characters palette contains algebraic symbols. 
Click and drag characters from the palette and drop them 
into an equation. Note: The palette can be dragged to any 
part of the screen. It need not interfere with viewing the 
problems. For more information about using the special 
characters palette, see pp. 5 1-52. 

After two more practice problems, a second example with three more 
practice problems will be presented; click OK when finished. 

Activity 2 - Solve 
This activity reinforces the concepts and skills that you used in Learn. 

Click to highlight the Solve icon on the Main screen. 
Select a Subject from the Subject menu. 
Select a Level from the Level menu. 
Click the Solve icon again to start the activity. (Select Start 
With from the Activity menu only if you want to begin with a 
particular problem.) 
Select an option for Solve: either Practice with Help or Solve 
on Your Own. 
Study the problem at the top of the screen. 

x + 4  2 x - 1  -+ - 

Solve Activity - 
Practice with Help 
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If you selected Practice with Help, you can ask for a hint. 
Enter the answer and click OK. 
If you want help either before or after attempting to answer, 
select Hints from the 
see the next hint. Scroll t to review hints.) 
To leave the hint box at any time, select Done. 
Enter the answer and click OK. 
Click OK again to go to the next problem. 

menu. (For more help, select More to 

Some of the answers in the Solve activity may require one 
of the special algebraic characters displayed in the special 
characters palette. Drag the character from the special char- 
acters palette and place it into the equation. The palette can 
be dragged to any part of the screen. It need not interfere 
with viewing the problems. For more about using the spe- 
cial characters palette, see pp. 5 1-52. 

If you selected Solve on Your Own, hints are not available. 
Enter the answer and click OK. You have two opportunities to 
answer correctly before the answer is supplied. 
Click OK to go to the next problem. 

There are between 10 and 15 problems in each file. When the score- 
board appears, press any key to return to the Main screen. 

Activity 3 - Translate 
In this multiple-choice activity you will translate words into algebraic 
expressions or algebraic expressions into words. 

Click to highlight the Translate icon on the Main screen. 
Select a Level (1-3) from the Level menu. (The Subject menu 
is not used with this activity.) 
Click the Translate icon again to select the activity. 
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Translate Activity 

F 

[Rl X / 1 7  

lil x * 1 7  

[cl x - 1 7  

[ol 1 7 - X  

3 Translations 

I 17 more than a number I 

Select a format option: Equation, Phrase, or Mixed. 
Read the phrase or equation at the top of the screen. 
Click the letter of the correct answer choice. You have two 
chances to answer correctly before the answer is supplied. 
Click or press <Return> to go to the next problem. 

When you finish the problems and the scoreboard appears, press any 
key to return to the Main screen. 

Activity 4 - Graph 
The Graph activity familiarizes students with the coordinate system 
and slopes of lines. 

Click to highlight the Graph icon on the Main screen. 
Select a Level (1 or 2) from the Level menu. (The Subject 
menu is not used with this activity.) 
Click the Graph icon again to start the activity. 

Level 1 
In this level, you will find and label points on a graph. 

Select an option: Find Point, Label Point, or Mixed. 
To turn on the timer, click on the timer box. 
Click OK to accept option choice(s). 
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Graph Activity - 
Level 1 

Find Po in t  

K7-T  

n 
I itl)t?l Point 

. . . . . . .  ..................... 

. . . . .  ............................ . . . . . . . . . . . . . .  . . . . . . . . . .  . . . . . .  . . . . . . .  ................... . . . . . . .  Timer  

I Wonderful! I 

Find Point 
Find the point that corresponds to the ordered pair displayed. 

Click the point or press the arrow keys to move the selection 
box onto the point. Double-click on the point or press <Return> 
to select it. The coordinates of the point on the graph will show 
in the Find Point box. 
Click or press <Return> to go to the next problem. 

Label Point 
Look for the circled point on the graph. 

Enter the corresponding ordered pair in the Label Point box on 
the right side of the screen. The comma will be supplied for 
you. To enter the point (3,4), type only 3 then 4; click or press 
<Return>. 
Click or press <Return> to go to the next problem. 

Mixed 
Mixed is a combination of the Find Point and Label Point options. 

Level 2 
In this level, you learn to predict and calculate slopes. 
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Select Find Point, Find Slope, or Mixed. 
To turn on the timer, click on the timer box. 
Click OK to accept option choice(s). 

Find Point 
Look at the coordinates displayed in the Point and Slope boxes. 

Use the slope and point 1 to find point 2. 
Use arrow keys or the mouse to move the selection box from 
point 1 to point 2. For example, if the slope is 4/5, move the 
box up 4 points and over 5 points to the right. 
Double-click when the box is at the correct coordinates. 
Click or press <Return> to go to the next problem. 

Find Slope 
Find the slope of the line between the two points on the graph. 
Their coordinates are displayed on the right side of the screen. 

Calculate the slope of the line between the two points by using 
the point slope formula (slope = y2-y1 / x2-xI). For example, if 
the first point is (3,2) and the second point is (5,4), the slope 
would be 4-2/5-3 = 2/2 = 1. Enter the slope with a slash (/) 
between the two numbers (rise/run); press <Return>. 
Click or press <Return> to go to the next problem. 

Mixed 
Mixed is a combination of the Find Point and Find Slope options. 

In the Graph Activity, you have two opportunities to answer correctly 
before the answer is supplied. If the timer is on, you have only 20 
seconds to answer, but you may have more than two tries. 

If you do not wish to have the grid background, select Grid from the 
Activity menu to turn it off. 
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Activity 5 - Alge-Blaster Plus Game 
In this arcade-style game, you will use your graphing knowledge to 
defend your space station against asteroids. 

Click to highlight the Alge-Blaster Plus Game icon on the 
Main screen. 
Select a Level (1-4) from the Level menu. 
Select Game Speed from the Activity menu; choose either 
Normal or Fast. 
Click the game icon again to start the activity. 

Asteroids are threatening your space station. Shoot a laser beam to 
destroy them before they hit the space station. To blast an asteroid: 

Click one of the four lasers in the comers of the space field or 
use arrows (use the keys A or Z if your keyboard does not have 
arrow keys) to select a laser. 
Enter a slope (e.g., 2/3); press <Return>. A laser beam will be 
launched at an angle equal to the slope you have entered. 
Lasers 1 and 3 require a positive slope, 2 and 4 require a nega- 
tive slope. (Laser numbers correspond to quadrant numbers.) 
Each laser can emit a maximum of 20 beams. (Beam remaining 
for the highlighted laser is shown at the bottom of the screen.) 
Hint: If you are having trouble visualizing the direction of a 
slope, enter a few slopes with similar coordinates. For example, 
enter 5/1, 5/2, 5/3, and 5/9 and notice the change in direction. 

Space webs can help you protect your space station by blocking the 
paths of asteroids. To create a space web: 

Click or <Tab> to select the Web Control box. 
Decide where you want to put the web and enter a coordinate 
pair for the first point. 
<Tab> and enter a coordinate pair for the second point; press 
<Return>. A line, or space web, will be drawn between these 
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points. Asteroids will bounce off this barrier. The web is only 
temporary and will disappear after 25 seconds. The web 
supply remaining is indicated at the bottom of the screen. 

Alge-Blaster Plus 
Game 

If your space station is destroyed three times, the game is over. If you 
successfully defend your station, you will advance a level. Levels be- 
come increasingly difficult (more asteroids appear at one time). 

Bonus 
As you advance to a higher level, a laser will be selected for you and 
an object will cross the screen. To earn bonus points, hit the flying 
object twice. You’ll also earn points for any unused beams and webs. 

Using Record Keeping 

Records are automatically saved to your Alge-Blaster Plus disk or 
your hard disk, if your program is hard disk installed. If you wish to 
save your records to a separate disk, you must indicate this when you 
save your file. 

Select Record Keeping from the File menu. (A J indicates 
the feature is on. Selecting the item again will turn it off.) 
Select Create a new file or Open an existing file; click OK. 

How to Use the Macintosh Version 47 



If you are creating a new file, a file requester box containing your 
sign-in name will appear. 

If you are adding to an existing record file, choose the record file you 
want to use. 

Select Save or enter another name for your file. 

Viewing and Printing a Record 
Select See Record or Print Record from the File menu. 
Double-click the name of the record file you wish. 
If you are printing, indicate the number of copies you wish, 
then click OK. If you have chosen to see the record, click 
Done when you are finished. 

Using the Editor 

Use the Editor to create your own algebra problems to use in the Solve 
activity. Custom data is automatically saved to your Alge-Blaster Plus 
disk or your hard disk, if your program is hard disk installed. If you 
wish to save your custom data to a separate disk, you must indicate 
this when you save your file. 

Select Editor from the File menu on the Main screen. 
From the File menu, select New to create a new data file; 
select Open to edit or add to an existing data file. 

Entering a Problem 

J You may enter up to 25 problems per file. 
J Use only the letters a, b, e, x, y, and z for the variables 

in your problems. 
J To use any of the special algebraic characters on the 

Editor screen, drag the character from the special 
characters palette and drop it into the equation. See pp. 1 

5 1-52 for more detailed instructions. 
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Step 1 - Enter an expression or equation. 
Enter a problem. (Use characters and variables mentioned.) 
On the lower portion of the screen, click to open the instruc- 
tion box. Scroll t or 4 to find the instruction or hint you want 
to have displayed with the steps of your problem, then double- 
click to select. See Appendix A on pp. 73-74 for a complete 
list of instructions and hints you may use. 
Using the vertical scroll bar, click 4 to scroll to another step 
(the step number is displayed at the top of the scroll bar). 

Editor - Step 1 

Problem - 

Step 2 - Enter the solution. 
Enter a solution using operators and symbols (and special 
characters if necessary). 
Open the instruction box and select an instruction to display. If 
you do not want any hints to appear, it is not necessary to open 
the instruction box. (None is selected automatically.) 
Using the vertical scroll bar, scroll 4 to Step 3. 

Step 3 - Enter an alternative solution if applicable. 
If the problem does not have two possible solutions, scroll 4 
to Step 4 using the vertical scroll bar. 
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Step 4 - Enter the first intermediate step (optional). 
Intermediate steps are used as hints in Practice with Help. If a student 
asks for help, the written hint is actually displayed first, then the nu- 
merical hint (step). There are 10 intermediate steps available. 

Enter an intermediate numerical step. 
Select a hint from the list. 

After entering your last intermediate step: 
You may review all the steps in the problem; scroll t using the 
vertical scroll bar. 
Click Problem Preview to view how the complete problem will 
be displayed in the Solve activity. 
Select Add from the Problem menu to add another problem to 
your file. Repeat the procedure above. 
Select Save as from the File menu when you are finished. (You 
may wish to review each problem before you close the file. To 
review, scroll * or .) using the horizontal scroll bar.) 
Insert the custom data disk if you wish to save to a separate disk. 
Enter a name for your new file and click the Save box. 

To review, edit, or add to an existing file: 
Select Open from the Editor’s File menu. Insert your custom 
data disk if desired; double-click the name of the file. 
To review each step in the problem, scroll t or 4 using the 
vertical scroll bar. 
To review each problem, scroll * or + using the horizontal 
scroll bar. 
Select Add from the Problem menu to add problems to your file. 
Select Insert to insert a problem in the middle of the file. 
Select Go to Problem # to access a specific problem to edit. 
Select Delete to delete an entire problem with all its steps. The 
problem on the screen is the one that will be deleted. 
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Select Duplicate to duplicate a problem on the screen. 
Be sure to save any changes you make to the file. 

Printing Data Files 

Access the Editor and open the file you wish to print. You may 
use original or custom files. 
Select Print from the File menu. 
Choose the number of copies and pages to print; select OK. 

Using Your New File With Solve 

Select Main Menu from the Editor’s File menu to go directly 
to the main program. 
Click to highlight the Solve icon on the Main screen. Do not 
double-click. 
Select Your File from the Level menu. (Your File is available 
only after the Solve icon has been highlighted.) 
Highlight the file you want to use; click OK. 
Click the Solve icon again to start the activity. 

Using the Special Characters Palette 

Small Fraction 
From the palette, drag the small fraction symbol and place it 
in the equation. A cursor and fraction bar will appear. 
Enter numbers and symbols in the numerator. The fraction bar 
will grow as numbers and symbols are entered. See next page. 
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Special Characters 
Palette 

Fraction 
,-.\ 

Large ....I 

Frrrction - 
Exponent xi-; 

Square -$- 
Root 
Pluslminus k 

. :  ...., 

Click or press + to move to the denominator; enter numbers 
and symbols in the denominator. Click or press * to move the 
cursor outside the fraction when finished. 

Large Fraction 
This works in the same manner as the small fraction, except that the 
cursor and the fraction bar are larger. 

Exponent 
Drag the exponent and place the x on top of the base. 
Enter the exponential number. Click or press * to remove the 
cursor from the exponent mode when finished. 

Square Root 
Drag the square root sign and place it in the equation. 
Enter the numbers to appear under the radical; the radical will 
grow to accommodate them. Click or press + to move the 
cursor out from under the radical sign when finished. 

PludMinus Sign 
Drag the plus/minus sign and place it in front of a number or 
variable. 
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Main Screen Menus 

About Rlge-Blaster Plus ... 
Help ... Bg? 
Terms... B g l  

Hints... BgH 

Desk Accessories here 

File 
N e w  Student.  .. 
Open %O 

Close 8gU 

Record Keeping ... 
See Record.. . 
Pr in t  Record... 

............................................................ 

Editor %E 
O u i t  XO 

Activity 
I Start 

Start With ... 
JSound 

Options %a 
/Grid 3% 
.." _....-..... . 

Subject 

Order of Ops. 
Mono. B Poly. 
Factoring 
Equations 
Systems o f  Eqs. 
Algebraic Fracs. 
Rad i c a I s 

About Alge-Blaster Plus - about the 

Help - on-screen instructions 
Terms - math terms and definitions 
Hints -hints for the Solve activity 

authors 

New Student - change student 
Open - open activity 
Close - close activity 
Record Keeping -turn ordoff 
See Record - view student's scores 
Print Record - print out scores 
Editor - enter new algebra problems 
Quit - exit the program 

Start - begin selected activity 
Start With - a specific problem in Solve 
Sound -turn on/off 
Options - change within an activity 
Grid - grid background for Graph 
Game Speed - choose Normal or Fast 

These are the subjects available in the 
Alge-Blaster Plus program. 
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Level 
/Level 1 

Leuel 2 
Leuel 3 
Leuel 4 n Your File 

fldd %fl 
Delete 8 0  
Duplicate 

- -  

Levels 1-4 are levels of difficulty of the 
problems within each subject area. 

Add - add a problem 
Delete - delete an entire problem 
Duplicate - duplicate a problem 

Your File - Use a custom data file 

Note: Items on the Edit menu may be accessed only from the Editor even 
though the menu is visible from the Alge-Bluster Plus program. 

Editor Menus 

I Tile 
New... XN 

Saue ... 4gS 
Saue as... 
close BgU 
Revert ... 
Page Setup ... 
Print ... X P  

MalnMenu %V 
nuit %O 

Open ... %O 

.. .................................................. 

..... " .......................................................... 

Edit 

Paste XU 

Select R l l  

New - create a new file 
Open - open an existing file 
Save - save file on disk 
Save as - name and save a new file 
Close - close an existing file 
Revert - go back to original file 
Page Setup - set up page for printing 
Print - print a complete file 
Main Menu - return to main program 
Quit - leave the program 

Undo - reverse last action 
Cut - remove to clipboard 
Copy - duplicate in memory 
Paste - place cut or copied data 
Select All - select all items 
Clear - cancel 

Problem 
I Insert %I Insert - insert a problem 

Goto Problem # ... %G Go to Problem ## - find a specific problem 
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HOW TO USE THE APPLE II FAMILY VERSION 

c . )  
to select menu 

System Requirements 

Integers 
Order of Op. 
Mono. 8 Poly. 
Factoring 
Equations 
Systems of Eq. 
Algebraic Frac. 
Radicals 
Quadratic Eq. 

J Apple IIGS, IIc+, IIc, or IIe with 128K 
J extended 80-column card 
J 1 or 2 drives, monitor (color or monochrome) 
J printer, mouse (optional) 

Moving Around in the Program 

Alge-Blaster Plus utilizes the Davidson Student Desktop Interface 
which allows you to move easily from one part of the program to 
another using mouse or keyboard. Menus are located on the menu bar 
at the top of the Main screen. 

t 
to select item 

If a menu item appears grayed or dimmed, it is temporarily unavailable 
and cannot be accessed. For example, because Graph has only two 
levels, Level 3 and Level 4 will be dim when the Graph activity is 
highlighted. A description of Main screen menu items is on page 71-72. 
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Selecting a Menu Item Using the Keyboard 

Press <Ex> to access (or leave) the menu bar. Press + or + 
to move to the menu you wish to access. 
Use t or 4 to select (highlight) a menu item; press <Return>. 

Selecting a Menu Item Using a Mouse 

Point to a menu title and click; the menu will drop down. 
Hold down the mouse button and drag the pointer to highlight 
the item you wish, Release the button to select it. 

Using Accelerator Keys 

Some menu items have keyboard shortcuts (e.g.; S for Stop). 
Press and the indicated letter key at the same time. 

Making Other Choices Using the Keyboard 

0 

0 

0 

56 

On the Main screen, use <Tab> or arrow keys to highlight an 
activity icon (picture). Press <Return> or select Start from the 
Activity menu to begin the activity. 
When choices on the screen are outlined or boxed, use <Tab> 
to highlight the item of your choice, then press <Return>. 
When input is required in more than one place on a screen (as 
in Setup or an options box), use <Tab> to move the cursor. 
Enter the information or press <Space> to mark. When all 
input is complete, <Tab> to the OK button and press <Return>. 
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Making Other Choices Using a Mouse 

Point and double-click the desired icon (picture). 
When options or choices on the screen are outlined or boxed, 
point and click the box of your choice. 
When input is required in more than one place on a screen (as 
in Setup or an options box), point and click to move the cursor. 
When all input is complete, click the OK box. 

Starting the Program 

Sign In 
Insert the Alge-Bluster Plus program disk, label side up, in 
drive 1 and turn on the computer. 
Enter your name (up to 11 characters). Press <Return>. 
Select the date using the keyboard * or + , or by clicking the 
mows on the screen; press <Return> or click OK. 

Select an Activity 
The five A@-Bluster Plus activities are represented by colorful icons 
(pictures) on the Main screen. 

Double-click an icon, or highlight the icon of your choice 
using t and 4 on the keyboard and press <Return>. 

S or select Stop from the Activity menu. To stop, press 

Printing 

Before printing a scoreboard, a certificate, or a student’s record, you 
must enter printer and interface information. 

Select Setup from the Main screen’s File menu. 
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Apple Setup 
Screen 

Alge-Blaster Plus Setup 

R 
El 

LineFeed: (Y.N) 

slot Nurkw: (1.7) 

R e c ~ d s  Data Pathname: 

RECORDS I 
Cuslwn Data Pathname: 

CUSTOM/ I 
[ T E q F l ~ i x q  

Line Feed: (Y-N) 
Enter N (No) if your printer has automatic line feed; other- 
wise, enter Y (Yes). Move the cursor to the next box. 

Slot Number: (1-7) 
Enter the slot number for your printer card (usually 1). 
(Note: You need not enter a pathname for Records or Cus- 
tom Data at this time. See Using Record Keeping and Using 
the Editor for instructions if you choose to use these features.) 
Select Save to save this information on the disk. 
Select Use to use these new settings temporarily. 
Select Cancel to escape from Setup without saving. 

To change any information on the Setup screen: 

Enter the new information. 
Press <Tab> or use the mouse to access the desired box. 

Select Save, Use, or Cancel. 

Using the  Activities 

Now that you are familiar with the Davidson Student Desktop Inter- 
face, you can begin mastering algebra. 
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Activity 1 - Learn 
This activity consists of example problems and practice problems. 

Highlight the Learn icon on the Main screen. 
Select a Subject from the Main screen’s Subject menu. 
Select a Level from the Level menu. 
Press <Return> or click the Learn icon. 

The first example problem will appear on the screen. 
Study the example problem. Press <Return> or click the 4 

when you are ready to continue. 
Study the next step; press <Return> or click the 4 .  
Continue viewing the demonstration steps in this manner. 
To review a previous step, press or click the t . 

After the example problem, the first of three practice problems will be 
presented along with instructions for the first step. 

I c File Activity Subiect Level Help 

Practice la  - Order (Integers) I 
4 - 2 * 8 + 4  

I+ Learn Activity 

II 
First, multiply and divide, working 
from left to right. 

I’ I 

Read carefully, then press <Return> or click the 4 . 
Enter the solution to the first step; press <Return>. (Use 
<Delete> to erase.) You have two opportunities to answer 
correctly. Otherwise, the correct answer will be supplied. 
Press <Return> when you are ready to go to the next step. 
Study the second step; press <Return> or click OK. 
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If you accidentally delete part of a problem 
that contains a special character, see page 70 
for directions on how to reenter it. 

Enter the second step solution; press <Return> or click OK. 
Continue completing steps until you solve the problem. 

If you wish to review the previous step, press R. Press t to con- 
tinue backwards or 4 to move forward through the steps. A second 
example problem and three more practice problems will be presented. 
After completing these, press any key to return to the Main screen. 

Activity 2 - Solve 
This activity reinforces the concepts and skills studied in the Learn 
activity. In the Solve activity, you will enter only the final answer. 

Highlight the Solve icon on the Main screen. 
Select a Subject from the Subject menu. 
Select a Level from the Level menu. 
Press <Return> or click the Solve icon. 
When the option box appears, select either Practice with Help 
or Solve on Your Own; press <Return>. 
Study the problem at the top of the screen. 

If you selected Practice with Help, you can ask for a hint. 
If you want help (before or after typing an answer), select 
Hints from the Help menu or press 
the information you need, press <Return>. (For more help, 
press or click C to see the next hint while you are still in the 
hint box. To review previous hints, press or click t .) 
To leave the hint box, press <Return> or click OK. 
Now you can continue solving the steps to the problem. 

H. If this hint gives you 
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C File Activity Subject Level Help 
Simplify. 

Solve Activity 

- - n  

Enter the answer; press <Return>. You have two opportunities 
to answer correctly. Otherwise, the correct answer is supplied. 
Press <Return> to go to the next problem. 

Note: Some answers may require the use of a special algebraic sym- 
bol or character. See page 70 for instructions on how to type these. 

If you selected Solve on Your Own, hints are not available. 
Calculate the answer, using paper and pencil if necessary. 
Enter the answer; press <Return>. 
Press <Return> to go to the next problem. 
There are between 10 and 15 problems in each file. When you 
finish the problems and the scoreboard appears, press any key 
to return to the Main screen. 

Activity 3 - Translate 
In this multiple-choice activity you will translate words into an 
algebraic expression or an algebraic expression into words. 

Highlight the Translate icon on the Main screen. 
Select a Level (1-3) from the Level menu. 
(Note: The Subject menu is not used with this activity.) 
Press <Return> or click the Translate icon. 
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Select Choose Equation, Choose Phrase, or Mixed. 
Read the phrase or equation at the top of the screen; then type 
or click the letter of the correct answer choice, or select it by 
using t or + and pressing <Return>. 

Translate Activity 

Great! 

a numbcr x dlulded by 25 Is 
,-I tk quotlent of a number y and ZB 

a number x dininirkd by 25 is @ 28 l e s s  than a number y 

@ a number y dluldcd by 28 

I number x diuided by 25 is @ I nunber y dininished by 28 

the quotlent of 25 and a nunbcr x is 

Press <Return> to go to the next problem. 

Activity 4 - Graph 
In this activity you will become familiar with the coordinate system 
and the slopes of lines. 

Highlight the Graph icon on the Main screen. 
Select a Level (1 or 2) from the Level menu. 
(Note: The Subject menu is not used in this activity.) 
Press <Return> or click the Graph icon. 

Level 1 
Select an option: Find Point, Label Point, or Mixed. 
To turn on the timer, click on the box, or press <Tab> to move 
to the timer box and press <Space> to select. 
Select OK to accept option choice(s). 
For a grid background, select Grid from the Help menu. 
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Graph Activity - 
Level One 

Find Point 
Look at the ordered pair displayed in the Find Point box on the 
right side of the screen. 
To locate and select the point on the graph, use keyboard 
arrows or click to move the selection box and press <Return>. 

Label Point 
Look for the boxed point on the graph. 
Enter the corresponding ordered pair in the Label Point 
box on the right side of the screen; press <Return>. (A comma 
will be supplied. To enter (3,4), type 3 and then 4.) 
Press <Return> to go to the next problem. 

Mixed 
Mixed is a combination of the Find Point and Label Point options. 

Level 2 
Select Find Point, Find Slope, or Mixed. 
To turn on the timer, click on the box, or press <Tab> to move 
to the timer box and press <Space> to select. 
Select OK to accept option choice(s). 
For a grid background, select Grid from the Help menu. 
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Find Point 
Look at the point coordinates and slope coordinates displayed 
on the right side of the screen. 
Use the slope and point 1 to find point 2. Use arrow keys or 
the mouse to move the selection box from point 1 to point 2. 
For example, if the slope is 4/5, move the box up 4 points and 
over 5 points to the right. 
Press <Return> or double-click when the selection box is at 
the correct point. 
Press <Return> to go to the next problem. 

Find Slope 
Calculate the slope of the line between the two points on the 
graph using the point slope formula (slope = y2-y1/x2-x1). For 
example, if the first point is (3,2) and the second is (5,4), the 
slope would be 4-2/53 = 2/2 =l. Enter the slope with a slash 
(/) between the two numbers (risehun); press <Return>. 
Press <Return> to go to the next problem. 

Mixed 
Mixed is a combination of the Find Point and Label Point options. 

You have two opportunities to answer correctly; then the answer will 
be supplied. If the timer is on, you have 20 seconds to answer. 

Activity 5 - Alge-Blaster Plus Game 
You will use your graphing knowledge to defend your space station. 

Highlight the Alge-Blaster Plus Game icon on the Main screen. 
Select a Level (1-4) from the Level menu. 
Select the Alge-Blaster Plus Game icon. 

To blast an asteroid with a laser: 
Select (highlight) a laser using the t and 4 keys. 
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Enter a slope (e.g., 2/3); press <Return>. A beam will be 
launched at an angle equal to the slope you entered. Lasers 1 
and 3 require a positive slope, 2 and 4 require a negative slope. 
Each laser can emit a maximum of twenty beams. (Amount 
remaining is shown at the bottom of the screen.) 
Hint: If you are having trouble visualizing the direction of a 
slope, enter several slopes with similar coordinates (e.g., enter 
5/1,5/2,5/3, and 5/9 and notice the change in direction). 

Alge-Blaster Plus 
Game 

Space webs can help you protect your space station by blocking the 
path of the asteriods. To create a space web: 

Press <Tab> to select the Web Control box. 
Decide where to put the web and enter a coordinate pair for the 
first point; do the same for the second point; press <Return>. 
A line, or space web, will be drawn between the points. Aster- 
oids will bounce off this barrier and explode. The space web is 
temporary and will disappear after 25 seconds. (The amount of 
web remaining is indicated at the bottom of the screen.) 

If your space station is destroyed three times, the game is over. If you 
successfully defend your station, you will advance a level. Levels be- 
come increasingly difficult (more asteroids appear at one time). 

How to Use the Apple Version 65 



Bonus 
As you advance to a higher level, a laser will be selected for you and 
an object will cross the screen. To earn bonus points, hit the flying 
object twice. You’ll also earn points for any unused beams and webs. 

Using Record Keeping 

This feature allows you to save your scores and keep a cumulative 
record. First, prepare a disk on which to save student records. 

Use your System Utilities disk to format a blank disk with 
ProDOS. Name the volume (disk) /RECORDS/ (or any name 
with no more than seven lettershumbers). 

Now start the Alge-Blaster Plus program and sign in. 
Select Setup from the File menu on the Main screen. 
In the Records Data Pathname box, type /RECORDS (or what- 
ever name you chose). 
Select Save or Use. You will be returned to the Main screen. 
Select Record Keeping from the File menu. (A J indicates the 
feature is on; selecting the item again will turn it off.) 
Insert your records disk. A File Selector box will appear. 

File Selector Box 

Name your records file. 

Filename: I DAVID I 
Pathname: /RECORDS/ 

KELLY 
CATHY 

Your filename will appear in the box; press <Return> or click 
Open to establish the new file on your records disk. 
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The program will ask you to insert the records disk at the end of each 
activity so that your score can be saved. 

Viewing a Record 

Insert your records disk. 
Select See Record from the File menu. 

When the File Selector box appears, use t or 4 to select a file. 
Select Open or press <Return>. 

Printing a Record 
Select Setup from the Main screen’s File menu. Make sure the 
information is correct. 
Select Print Record from the Main screen’s File menu. 
When the File Selector box appears, use t or 4 to select a file. 
Select Open or press <Return>. 

Using the Editor 

Use the Editor to create your own algebra problems to use in the Solve 
activity. First prepare a disk on which to save your new data. 

Use your System Utilities disk to format a blank disk with 
ProDOS. Name the volume (disk) /NEWDATA/ or any 
name with no more than seven letters/numbers. 

Start the program and sign in, then tell the program where to find your 
newly formatted data disk. 

Select Setup from the File menu on the Main screen. 
In the Custom Data Pathname box, type /NEWDATA or 
whatever you named your custom data disk. 
Select Save or Use. You will be returned to the Main screen. 
Select Editor from the File menu on the Main screen. 
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Select New from the Editor’s File menu. 
Insert your custom data disk. Select OK. 
Enter the name of your new file in the Filename box (letters 
and numbers only; begin with a letter). 
Click Open or press <Return>. 

Entering a Problem 

J You may enter up to 25 problems per file. 
J Use only the letters a, b, e, x, y, and z as variables. 
J Pressing D or d creates a division sign. 
J To use any of the special algebraic characters which 

appear at the bottom of the Editor screen, press 
the number of the character at the same time. See pg. 70. 

and 

Step 1 - Enter an expression or equation. 
Enter a problem. 
Use <Space> to center the problem on the screen; press 
<Return>. (The problem will appear exactly as entered.) 
Use t and 4 to select the instruction to be displayed with the 
problem; press <Return>. (See Appendix A for a list.) 

Editor Screen - 
Step 2 

I C  File Problem Step 1 
File3a 

6a - 3 + 3 = 9 + 3 
Use up and down arrows to select 

I 

12 
To subtract a number, add its opposite. II 

I I 

c II+c 21\rle 3 H c  4[;;;1 t 5a 
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Step 2 - Enter the solution. 
Enter a solution using operators and symbols. 
Center the solution with <Space>; press <Return>. 
Use t or I to select an instruction. (Select hint number zero 
if you do not want any hint to appear.) Press <Return>. 

Step 3 - Enter an alternative solution if applicable. 
If none, press <Return>, select hint number zero, and press <Return>. 

Step 4 - Enter the first intermediate step (optional). 
Intermediate steps are used as hints in Practice with Help. If a stu- 
dent asks for help, the written hint is actually displayed first; the 
numerical hint (step) is displayed as the second hint. There are ten 
intermediate steps available. Use as many as you wish. 

Enter an intermediate numerical step; press <Return>. 
Select a hint from the list; press <Return>. 

After entering your last intermediate step: 
Select Next Prob from the Problem menu to add more prob- 
lems to your file. Repeat the procedure above. 
Select Save from the File menu when you are finished. (You 
may wish to review each problem before you close the file.) 
Select Close to close the file. 

To edit or add to an existing file: 
Select Open from the Editor’s File menu. 
Insert your custom data disk. Select OK. 
Use t or I to select the file; press <Return> or click Open. 
Add problems or select Go to Prob # from the Problem menu 
to access a specific problem. Be sure to save any changes you 
make to the file. 
Select Insert Prob or Delete Prob from the Problem menu to 
insert a problem or delete a problem. 
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Using Your New File With Solve 

Select ABP from the Editor’s File menu to go directly to the program. 
Select Setup from the Main screen’s File menu. 
<Tab> to the custom data box and enter the name you gave 
your custom data disk; select Save or Use. 
Highlight the Solve icon but do not press <Return>. 
Select Your File from the Level menu. (Your File is available 
only after the Solve icon has been highlighted.) 
From the File Selector box, select a file and press <Return>. 
Select the Solve icon on the Main screen. 

Using Special Algebraic Characters 

Place the cursor where you want the character to appear, then press 
and the number key at the same time. The special character key 

will remain highlighted on the screen while you are in that mode. 

1 
c 2 

3 
4 

The plus/minus sign will be displayed on the screen. 
The radical expands as you enter numbers. To exit the 
radical mode, press the same keys again. 
Enter an exponent. To exit the exponent mode, press + . 
Enter the numerator. Press .) to move the cursor to the 
denominator; enter the denominator. To exit the fraction 
mode, press the + key again. 
The small fraction key allows you to include small frac- 
tions within large fractions. Enter the numerator. Press 
.) to move the cursor to the denominator; enter the de- 
nominator. Press .) again to exit this mode. 

5 
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Main Screen Menus 

File 
New Student 
Record Keeping 

See Record 
Print Record 
Setup 
Editor t E 
Quit c Q  

_ _ _ _ - - _ _ - - - -  

Activity 
Start 
Start with 
stop 
Sound 

Options e o 
Review Text c R 

_ _ _ _ _ _ - - _ _  

Subject 

Integers 
Order of Op. 
Mono. & Poly. 
Factoring 
Equations 
Systems of Eq. 
Algebraic hac. 
Radicals 
Quadratic Eq. 

Level 

J Level 1 
Level 2 
Level 3 
Level 4 
Your File 

New Student - change student 
Record Keeping - turn on/off 
See Record - view student scores 
Print Record - print out scores 
Setup - printer and pathname information 
Editor - access to create new data files 
Quit - exit the entire program 

Start - begin selected activity 
Start with - begin on a specific problem 
Stop - exit from an activity 
Sound - turn on/off 
Options - change within an activity 
Review Text - see previous explanation 

These are the subjects available in the 
Alge-Blaster Plus program. 

Levels 1 4  are levels of difficulty of the 
problems within each subject area. 

Your File - use a custom data file 
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Editor Menus 

Info - activity instructions 
Terms - algebraic terms and definitions 
Hints - for Practice with Help option 
Grid - lines for Graph activity 

File (Editor) 
New - create a new file 
Open - open an existing file 
Save - save a file 
Close - close a file 
ABP - return to Main screen 
Quit - exit the program 

_ _ _ _ -  

Problem (Editor) 

Next Prob 
Prior Prob 
Insert Prob 
Delete Prob 
Go to Prob# CG 

Step (Editor) 

Next Step 
Prior Step 
Inseastep C I 
Delete Step C D 
Undo C U  

Next Rob - advance to next problem 
Prior Rob - move to previous problem 
Insert Prob - insert a problem 
Delete Prob - delete a problem 
Go to Prob # - go to a specific problem 

Next Step - move to the next step 
Prior Step - move to the previous step 
Insert Step - insert a step 
Delete Step - delete a step 
Undo - cancel last input or deletion 
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APPENDIX A - INSTRUCTIONS AND HINTS 

Instructions and hints available to use with your own data files: 
0. 
1. 
2. 
3. 
4. 
5. 
6. 
7. 
8. 
9. 

10. 
11. 
12. 
13. 
14. 
15. 
16. 
17. 
18. 
19. 
20. 
21. 
22. 
23. 
24. 
25. 
26. 
27. 
28. 
29. 
30. 
31. 
32. 
33. 
34. 
35. 

No prompt selected for this step. (For Macintosh users None is the hint.) 
Solve. 
Factor. 
Reduce. 
Simplify . 
Find the sum. 
Find the difference. 
Find the product. 
Find the quotient. 
Find the solution set. 
Subtract smaller absolute value from larger. 
Determine sign. 
To subtract a number, add its opposite. 
Determine sign and add. 
Determine sign and subtract. 
Determine sign and multiply. 
Determine sign and divide. 
Express meaning of exponent(s). 
Evaluate inside parentheses. 
Evaluate using exponent(s). 
Multiply or divide from left to right. 
Add or subtract from left to right. 
Group coefficients of like terms. 
Combine coefficients. 
Distribute ncgative sign. 
Regroup coellicients and variables. 
Multiply whcre indicated. 
Multiply cocfficients and add exponents of like terms. 
Raise monomials to indicated powers. 
Raise coefficicnts and variables to indicated powers. 
Use Distributive Propcrty of Multiplication. 
Use Addition Property of Equations. 
USC Multiplication Propcrty of Equations. 
Use the FOIL method. 
Combine like terms. 
Use APOE to collcct variables on one side. 
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36. 
37. 
38. 
39. 
40. 
41. 
42. 
43. 
44. 
45. 
46. 
47. 
48. 
49. 
50. 
51. 
52. 
53. 
54. 
55. 
56. 
57. 
58. 
59. 
60. 
61. 
62. 
63. 
64. 
65. 
66. 
67. 
68. 
69. 
70. 
71. 
72. 
73. 
74. 

Factor out the GCF. 
Factor using trinomial method. 
Determine separation of linear term. 
Factor GCF out of each binomial. 
Add equations. 
Determine remaining variable by substitution. 
Multiply equation(s) by a constant. 
Substitute variable expressions. 
Use APOE to isolate a variable. 
Rewrite equation to isolate variable. 
To divide, subtract exponents. 
Multiply numerators, multiply denominators. 
Combine fractions with common denominators. 
Rewrite as fractions with common denominators. 
Raise each fraction to higher terms. 
Multiply both sides of the equation by LCD. 
Factor as squares. 
Factor the radicand using a perfect square. 
Write as a single radical. 
Rationalize the denominator. 
Combine like radicals. 
Set each factor equal to zero and solve. 
Write in standard quadratic form. 
Identify coefficients a, b, and c. 
Use quadratic formula to solve. 
Write ordered pair. 
Change division to multiplication by reciprocal; factor. 
Write in simplest radical form. 
Reduce coefficicn ts. 
Factor denominators and find LCD. 
Take square root of perfect squares. 
Rewrite as a product of two binomial factors. 
Simplify and wiite as a solution set. 
Find square root of first and third terms. 
Simplify by cancelling common factors. 
Factor and gather together as one fraction. 
Factor using general trinomial method. 
Evaluate numerator and denominator. 
Rewrite as a product of GCF and binomial factors. 

74 Instructions a n d  Hints 



APPENDIX B - TROUBLESHOOTING GUIDE 

MS-DOS 

If your installed mouse does not work - Go to Setup and select the 
pointing device that you are using. 

If you cannot print, or the following message is displayed: Unable 
to locate DMPDIBMM.RRS - An incorrect printer might be selected. 
Go to Printing in the Setup menu and select ASCII in the Printer box. 
This is the only printer driver Alge-Blaster Plus uses. 

If no custom data or record-keeping files are displayed in the File 
box - The wrong drive may have been selected, or there may be no 
files on the custom data disk (or records disk). Only the drive letter 
will show in  the box. 

If the program is asking for a specific file - Check the disk labels to 
locate filenames. If the program continues to ask for a file even 
though you’ve selected Cancel, you must insert the disk with the 
requested file in order to continue. 

Macintosh 

If you have sound problems and/or the program crashes -You are 
using a machine with less than 1 megabyte of memory, or your system 
disk has not been updated to System 6.04. 

If the program will not read your datdrecords disk -The disk 
name currently being read is displayed in a box at the top ofthe screen. 
Select Drive in the file requester box to read a disk in another drive. 

If your keyboard does not have arrow keys - In Alge-Blaster Plus 
arrows are used in the game and with the special characters palette 
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(for Learn, Solve, and the Editor). In the game, use the A and Z keys 
instead of the up and down arrows to move between lasers. In Learn, 
Solve, and the Editor, click to move out of a special character mode. 

If you cannot view a complete example problem in the Learn 
activity - You are selecting Continue too soon. First press the 4 on 
the vertical scroll bar to view all the steps of the example problem. 
Then select Continue to advance to the practice problems. 

If the Subject menu is grayed out - It is not available for that activ- 
ity. (Translate, Graph, and the Alge-Blaster Plus Game do not use the 
Subject menu. ) 

If you cannot print - Check to make sure your printer is turned on, 
the paper is not jammed, and the cables are not loose. 

Note: Do not rename program data files after installing the program to 
your hard disk. 

If you get the message “Unable to load ProDOS” - You are using 
an MS-DOS disk, or your disk is damaged or defective. Return the 
disk for replacement. 

If a menu item is fuzzy or “grayed” - This means that the menu 
item is not available at this time. 

If you cannot print - Check the printer slot in Setup; turn on the 
printer. 

If the program will not accept your data/records disk -The 
incorrect drive, volume, or pathname information might be entered in 
Setup, or it might be missing a slash. 
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INDEX 

accelerator keys 
Apple 56 
Mac 38 
MS-DOS 12 

activities 
descriptions of 2-7 
objectives 2-7 
scoring 7 
selecting, Apple 56 
selecting, Mac 38 
selecting, MS-DOS 18 
skills 3, 5 ,  6,7  

Alge-Blaster Plus Game 
Apple 64-66 
Mac 46-47 

overview 6-7 
MS-DOS 25-26 

certificate 8 
custom files 

creating 
Apple 67-69 
Mac 48-51 
MS-DOS 28-31 

using 
Apple 70 
Mac 51 
MS-DOS 31 

Editor, Apple 
access 67-68 
add 69 
close 69 
entering problems 68-69 
menus 72 
pathname 67 
save 69 
special characters 68,70 

Editor, Mac 
access 48 
add 50-51 
entering problems 48-5 1 
menu 54 
save 50 
special characters 48, 51-52 

Editor, MS-DOS 
access 28-29 
add 30-31 
entering problems 29-30 
menu 34 
save 30 
special characters 29, 32 

Editor, overview 8 
Graph, the activity 

Apple 62-64 
Mac 4 3 4 5  

overview 5-6 
hard disk install, Macintosh 39 

run program from 39 
hard disk install, MS-DOS 13-14 

run program from 14 
subdirectories 13 
uninstal 13-14 

Apple 72 
overview 8 

instructions and hints 73-74 
keyboard, Apple 

MS-DOS 22-24 

Help menu 

menu item, selecting 56 
other choices 56 

keyboard, Macintosh 38 
keyboard, MS-DOS 

menu item, selecting 11 
other choices 12 
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Learn, the activity 
Apple 59-60 
Mac 39-41 

overview 2-3 

Editor menus 72 
Main screen menus 71-72 

Editor menus 54 
Main screen menus 53-54 

Editor menus 34 
Main screen menus 33-34 

menu item, selecting 56 
other choices 57 

MS-DOS 18-20 

menus, Apple 

menus, Macintosh 

menus, MS-DOS 

mouse, Apple 

mouse, Macintosh 37-38 
mouse, MS-DOS 

menu item, selecting 12 
other choices 12-1 3 

moving around in the program 
Apple 55 
Mac 37-38 
MS-DOS 11 

options 8 
overview of program 1-10 
printing 

Apple 8, 57-58, 67 
Mac 8,48, 51 
MS-DOS 8, 17,28 

Record Keeping, using 
Apple 66-67 
Mac 47-48 
MS-DOS 26-28 

scoring 
Alge-Blaster Plus Game 7 
Graph 7 
Solve 7 
Translate 7 

Setup, using 
Apple 57-58 
MS-DOS 16-18 

signing in 
Apple 57 
Mac 39 

Solve, the activity 
Apple 60-61 
Mac 41122 

overview 3-4 

Apple 70 

MS-DOS 16 

MS-DOS 20-21 

special characters 

Mac 51-52 
MS-DOS 32 

starting the program 
Apple 57 
Mac 39 

Student Aid menu 

overview 8 
system requirements 

Apple 55 
Mac 37 

MS-DOS 14-16 

MS-DOS 34 

MS-DOS 11 
teaching tips 

Graph 10 
Learn 9 
Solve 9 
Translate 9-10 

Translate, the activity 
Apple 61-62 
Mac 42-43 

overview 4-5 
MS-DOS 21-22 

troubleshooting guide 75-76 
troubleshooting, starting the 

program, MS-DOS 35-36 
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Personal Trainer"" for 
Get better scores with Your Personal Trainer for the 
SAT, the only program that creates personalized study 
schedules. Your practice test results are analyzed and 
tailored to a txaining program that addresses your specific 
strengths and weaknesses. You'll build vocabulary, 
reading, and math skills as you study practice SAT 
questions and learn test-taking strategies. 
IBM. Mac 

Teaches strategies for solving math word problems and 
develops pre-algebra and critical thinking skills. Helpful 
hint screens offer instructions, formulas, and definitions, 
and the popup calculator makes calculating a breeze. Use 
the editor to customize the program with your own word 
problems. 
IBM, Mac 

Designed by reading specialists, Speed Reader helps 
students increase reading speed and improve 
comprehension. Si separate activities using 35 reading 
selections lead you through a step-by-step learning 
process. Learn to read faster and understand more! 
Windows version now available. 
IBM, Apple, Mac, Windows 

Get into the swing of learning geometry as you help our 
colorful cast of characters solve real-life geometry 
problems in What's My Angle? Learn basic geometry 
concepts and problem-solving skills and see how they 
apply to everyday situations. 
IBM 

Davidson. 
Davidson & Associates, Inc. 

P.O. Box 2961 
Torrance, CA 90509 

Sales 0 (800) 545-7677 
Customer Service 0 (800) 556-6141 
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